
8 – 1Introducing the Spreadsheet

This chapter introduces Microsoft Excel, a powerful spreadsheet
application used to store numeric data and perform calculations.

 8.1 What is a Spreadsheet?

A spreadsheet is data displayed in rows and columns. The term comes
from the field of accounting where business activities were tracked on
large sheets of paper that spread out to form a “spreadsheet.” A spread-
sheet application, such as Microsoft Excel, is used to electronically store
data. In Excel, spreadsheet files are called workbooks, and each workbook
contains three worksheets, also called sheets.

Worksheets are used to present data in an organized format:

The name Jones, D., the test grades 85, 73, 88, 95, and the average 85.3
form a row. Rows 4 through 9 store the name, test grades, and average
for six students. The title Test 1, date 1/7/2003, and test grades from 85
to 70 form a column. Columns B through E each store a title, date, and
all of the grades for a single test.

Benefits of using a spreadsheet application include the ability to eas-
ily perform calculations on data and to automatically recalculate values
when changes are made to the data. For example, the spreadsheet above
is set up to calculate student averages. If a test grade is changed, the
corresponding average will automatically recalculate.

Spreadsheet Uses
Spreadsheets are widely used
by businesses for payroll and
inventory and by individuals
for personal budgets and
calculating education costs.

spreadsheet application
workbook
worksheet
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 8.2 Creating a New Excel Workbook

Selecting New Office Document from the Start menu on the Windows
Taskbar displays the New Office Document dialog box. Clicking the Blank
Workbook icon and then selecting OK starts Excel and creates a new,
empty workbook. The first worksheet in the workbook is displayed:

• Letters at the top of the worksheet identify individual columns.
In Excel columns are lettered from A to Z and then AA to IV for
a total of 256 columns. In the worksheet above, only columns A
through L are displayed.

• Numbers down the left side of the worksheet identify individual
rows. In Excel, rows are numbered from 1 to 65,536. In the
worksheet above, only rows 1 through 25 are displayed.

• Scroll bars are used to display rows and columns that are not
currently visible in the worksheet.

• A cell is the intersection of a row and column. Each cell can store
a single item of data.

• A cell reference is the column letter and row number that iden-
tify a single cell. For example, B5 is the cell reference of the se-
lected cell in the worksheet above.

• The selected cell is called the active cell and is displayed with a
bold outline. In the worksheet above, cell B5 is the active cell.
The column letter and row number corresponding to the active
cell are blue. Data can only be entered into an active cell.

• The Name box displays the cell reference of the active cell, which
is B5 in the worksheet above.

• The Formula bar displays the contents of the active cell.

• The sheet tabs are used to display the three worksheets in the
workbook.

Creating a New
Workbook

If Excel has already been
started, selecting New from the
File menu displays the New
Workbook task pane. On the
New Workbook task pane,
clicking Blank Workbook cre-
ates a new workbook. A new
workbook can also be created
by selecting the New button
( ) on the toolbar.

Cell Reference
vs.

Cell Contents
Each cell is identified by its
cell reference, such as A3 or
C2, and each cell can contain
data, such as the number 5 or
the text Total. This system is
similar to mailboxes at the
post office where each box (or
cell) has a name and can store
information. Be careful not to
confuse the cell reference
with the data it stores.

The Formula Bar
If the Formula bar is not
displayed, select Formula Bar
from the View menu.
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 8.3 The Active Cell

When the pointer is moved onto the worksheet, it changes from an
arrow shape to a plus sign ( ). Clicking a cell makes it the active cell.

The keyboard can also be used to change the active cell. Pressing an
arrow key makes the next cell in that direction the active cell. Pressing
the Home key changes the active cell to the first cell in the row. Pressing
Ctrl+Home changes the active cell to cell A1. Pressing the Page Up or
Page Down key changes the active cell to a cell one screen up or down,
respectively.

 8.4 Entering Data into a Worksheet

Worksheets can store three types of data: labels, values, and
times/dates. Labels are text and cannot be used in calculations. Values
are numeric and can be used in calculations. Times/dates are either a time,
such as 12:10 PM, or a date, such as 6/4/2003. A time/date entry may be
used in some calculations. In the worksheet in Section 6.1, student names
and titles (such as Jones, D. and Test 1) are labels, test grades (such as
85) are values, and a date (such as 1/7/2003) is a time/date. Labels are
left aligned and values and times/dates are right aligned in worksheet
cells:

Data is entered into a cell by selecting that cell and then typing the
data. As data is typed, it appears in the cell and on the Formula bar, and
the Cancel and Enter buttons are activated:

Clicking the Enter button ( ) enters the data and leaves the active cell in
its current position. Clicking the Cancel button ( ) cancels data entry
and restores the original contents of the cell. The keyboard can also be
used to perform similar actions:

• Pressing the Enter key enters the data and then selects the next
cell in the column.

• Pressing the Tab key enters the data and then selects the next
cell in the row.

• Pressing an arrow key enters the data and then selects the next
cell in the direction of the arrow key.

• Pressing the Esc key cancels data entry and restores the original
contents of the cell.

Date Interpretation
If a date is entered with a two-
digit year, Excel interprets
years 00 through 29 as the
years 2000 through 2029 and
interprets years 30 through 99
as the years 1930 through
1999.

Note that if a cell is formatted
to display the date with a two-
digit year, the Formula bar still
displays the four-digit year.

AutoComplete
As data is typed into a cell , if
the data matches the first few
characters in a cell above, Ex-
cel fills in the remaining char-
acters. This feature is called
AutoComplete. Pressing Enter
accepts the entry, or continu-
ing to type replaces the
AutoComplete entry.

The Go To Command
Selecting Go To from the Edit
menu displays a dialog box
with options that allow you to
make a specific cell active
quickly.

Scrolling
The active cell does not
change when the scroll bars
are used. If the active cell is
not displayed after scrolling,
pressing Ctrl+Backspace
scrolls back to the active cell.
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An efficient method of entering data across a row is to use the Tab
key, which enters the data and then selects the next cell in the row. Once
the row is complete, Excel is able to recognize a pattern and pressing the
Enter key selects the cell in the first column that contains data in the next
row. For example, cell A2 is selected when the Enter key is pressed after
typing the data for cell D1:

The numeric keypad can make the entering of large amounts of nu-
meric data more efficient. Most keyboard require pressing the Num Lock
key on the numeric keypad before numbers can be entered.

If a mistake is made when entering data, it can be corrected by select-
ing the cell and entering the correct data. The new data then replaces
any previous data. If the mistake is noticed while typing the data, the
Backspace key can be used to delete one character at a time.

 8.5 Editing Cell Contents

Data in a cell is edited by first selecting the cell to display its contents
on the Formula bar. Next, clicking the Formula bar creates an insertion
point, which allows characters to be entered or deleted. The insertion point
is a blinking vertical line that indicates where the next character typed
will be placed. When the data has been corrected, the Enter button is
clicked or the Enter key is pressed.

The contents of a selected cell are erased by pressing the Delete key. If
a cell is cleared by mistake, immediately selecting Undo (Ctrl+Z) from
the Edit menu or the Undo button ( ) on the toolbar restores the con-
tents of the cell. Clicking the Undo button arrow displays a list of the
last 16 actions performed. Selecting an option from the list will undo that
particular action. Note that saving a worksheet clears the list of any pre-
vious actions.

 Practice 1

In this practice you will create a new workbook and enter data.

!!!!! CREATE A NEW WORKBOOK
a. On the Taskbar, click Start j New Office Document. The New Office Document dialog box is

displayed.

1. Click the Blank Workbook icon to select it.

2. Select OK. Excel starts and a new, empty workbook is created and the first worksheet
in the workbook is displayed. Note the features of the Excel window.

Editing in a Cell
Cell contents can be edited by
selecting a cell and then
pressing the F2 key, which
displays the insertion point in
the cell.

The insertion point is also
displayed in the cell by
double-clicking a cell.

efficient data entry

replacing cell data

numeric keypad
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@@@@@ ENTER COLUMN LABELS IN ROW 1
a. Note that A1 is the active cell. Type Name and then click the Enter button ( ). Cell A1 now

contains the label Name. Note that the active cell’s contents are displayed on the Formula
bar.

b. Press the right-arrow key to select cell B1, then type Test 1.

c. Press the Tab key. The label is entered and the next cell in the row is active.

d. Type Test 2.

e. Press the Tab key. The label is entered and cell D1 is the active cell.

f. Continue this procedure to place the labels Test 3 in cell D1 and Test 4 in cell E1.

##### ENTER THE TEST DATES
a. Click cell B2 and type the date 1/7/2003. Click the Enter button. Note that Excel right aligns

the date when it is entered into the cell.

b. Select cell C2, type the date 2/9/2003 and then press the Tab key. The data is entered and D2
is now the active cell.

c. Enter the date 3/1/2003 in cell D2 and the date 4/1/2003 in cell E2.

$$$$$ ENTER THE STUDENT NAMES AND GRADES
Enter the following labels and values starting in cell A4 by typing the label or value and press-
ing the Tab key to enter the data and move to the next cell in the row. Press Enter at the end of
the row.

Jones, D. 85 73 88 95

Neave, C. 92 88 85 91

Garcia, E. 72 63 67 72

McCallister, T. 87 92 85 93

Smith, L. 94 91 93 84

Bell, M. 70 74 80 85

%%%%% EDIT A GRADE
a. Select cell E9.

b. On the Formula bar, click to the right of the number 5. The insertion point appears.

c. Press the Backspace key once to delete the number 5.

d. Type a 3 and then press Enter. The grade is now an 83.

Check – Your worksheet should look similar to:

Note that the appearance of the worksheet will be modified in Practice 2 and Practice 3.
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 8.6 Saving, Closing, and Opening a

Workbook and Quitting Excel

Selecting Save (Ctrl+S) from the File menu or clicking the Save button
( ) on the toolbar saves the workbook. If the workbook is new and has
not yet been named, the Save As dialog box is displayed. Excel uses the
default name Book1 for a new workbook. This should be changed to a
descriptive file name. Excel automatically adds the .xls extension to the
file name. After saving a workbook, it should be closed if no longer
needed by selecting Close from the File menu.

If Excel is running, a workbook can be opened by selecting Open
(Ctrl+O) from the File menu or by clicking the Open button ( ) on the
toolbar, which displays the Open dialog box. If Excel is not running, a
workbook can be opened by selecting Open Office Document from the Start
menu on the Windows Taskbar, which displays the Open Office Docu-
ment dialog box.

When Excel is no longer needed, it should be quit properly so that any
worksheets in memory are not damaged or lost. Quitting Excel means
that the application window is closed and the program is no longer in
the computer’s memory. Excel is quit by selecting Exit from the File menu
or by clicking the Close button ( ) in the upper-right corner of the ap-
plication window. Attempting to quit Excel with an open worksheet that
has been edited but not saved displays a dialog box asking if you want
to save the worksheet.

 8.7 Previewing and Printing a

Spreadsheet

Selecting Print Preview from the File menu or the Print Preview button
( ) on the toolbar displays the worksheet as it will appear when printed.
Features of Print Preview include:

 Zoom button   Enlarges the view so the data is easier to
read.

 Print button   Displays the Print dialog box.

 Close button   Returns to Normal view. Pressing the Esc
key also returns to Normal view.

If the worksheet display is correct in Print Preview, it can be printed
by clicking the Print button which displays the Print dialog box. Select-
ing OK prints the portion of the worksheet that contains data. A worksheet
should be saved before it is printed since a problem with the printer could
cause the program to stop responding, resulting in the worksheet being
lost.

A worksheet can also be printed by selecting Print (Ctrl+P) from the
File menu, which displays the Print dialog box. Selecting OK prints the
portion of the worksheet that contains data. Clicking the Print button on
the toolbar prints one copy of the worksheet using the default settings
without displaying the Print dialog box.

Checking the Spelling
The spelling checker can help
to ensure accurate spelling of
text in a worksheet. Text is
spell-checked by clicking the
Spelling button ( ) on the
toolbar or by pressing the F7
key. Checking begins at the
active cell. Cells that do not
contain text are ignored. Se-
lecting a range of cells (refer
to Section 6.10) before spell
checking checks only the se-
lected range.

Dashed Lines
After print previewing a
spreadsheet, dashed lines
appear on the spreadsheet.
The dashed lines indicate
where one printed page ends
and the next begins. Dashed
lines also appear after printing
a spreadsheet.
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Gridlines and row and column headings can make a worksheet print-
out easier to read. Gridlines are solid lines that mark off the rows and
columns, similar to what appears on the screen in Excel. Row and column
headings are the row numbers and column letters. Selecting Page Setup
from the File menu displays the Page Setup dialog box. Selecting the Sheet
tab displays the options.

Selecting the Gridlines and Row and column headings check boxes and then
selecting OK displays gridlines and row and column headings when the
worksheet is previewed or printed.

 8.8 Adding a Header and Footer

Information such as the date or the file name can be included in a
header or footer to help identify printouts. Headers and footers are au-
tomatically printed at the top and bottom of each worksheet page,
respectively. A header or footer is added to a worksheet by selecting Page
Setup from the File menu, which displays the Page Setup dialog box. Se-
lecting the Header/Footer tab displays the options:

Headers and Footers
Headers and footers can also
be added in Print Preview. In
Print Preview, selecting the
Setup button displays the Page
Setup dialog box. Selecting
the Header/Footer tab displays
options for creating headers
and footers.
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Selecting Custom Header or Custom Footer displays another dialog box
where header or footer text is entered. For example, selecting Custom
Header displays the Header dialog box:

Text typed in the Left section, Center section, or Right section boxes is left,
center, or right aligned in the header, respectively. Buttons in the dialog
box are used to insert codes at the insertion point:

 Font button formats header and footer text.

 Page Number button inserts the current page number.

 Total Pages button inserts the total number of pages.

 Date button inserts the current date.

 Time button inserts the current time.

 Path & File button inserts the path and file name.

 File Name button inserts the file name.

 Sheet Name button inserts the sheet name. (Sheets names are
discussed in Chapter 8.)

 Insert Picture button inserts a picture.

 Format Picture button modifies an inserted picture.

When the worksheet is previewed or printed, the codes are replaced with
the appropriate information.

 Practice 2 ööööö

In this practice you will add headers and footers to a worksheet and then save the worksheet. The worksheet
created in Practice 1 should still be displayed.

!!!!! CREATE A HEADER AND A FOOTER
Select File j Page Setup. A dialog box is displayed.

1. Select the Header/Footer tab if those options are not already displayed.

Viewing Headers and
Footers

Headers and footers can be
viewed by selecting Print
Preview from the File menu.

If a header or footer contains
a picture or more than a
couple of lines of text,  it may
overlap with the worksheet
data. In the Print Preview
window, selecting Margins dis-
plays the header, top, bottom,
and footer margins. If there is
an overlap problem, the mar-
gin handles can be dragged to
the correct position on the
page.
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2. Select Custom Header. The Header dialog box is displayed.

a. Click in the Center section box. The insertion point appears.

b. Click the Date button ( ). The code &[Date] is placed in the box.

c. Select OK. The dialog box is removed.

3. Select Custom Footer. The Footer dialog box is displayed.

a. Click in the Right section box and then type your name.

b. Select OK. The dialog box is removed.

4. Select OK. The dialog box is removed.

@@@@@ PREVIEW THE WORKSHEET
a. Select File j Print Preview. The worksheet is displayed in print preview. Note the header and

footer. Also note how it is difficult to read the worksheet data because there are no gridlines
or row and column headings.

b. Select Close to return to Normal view.

c. Select File j Page Setup. A dialog box is displayed.

1. Select the Sheet tab to display those options.

2. Select the Gridlines check box.

3. Select the Row and column headings check box.

4. Select OK. The dialog box is removed.

d. On the toolbar, click the Print Preview button ( ). Note how much easier the worksheet is
to read.

e. Select Close to return to Normal view.

##### SAVE THE WORKBOOK AND THEN PRINT THE WORKSHEET
a. Select File j Save. A dialog box is displayed.

1. Use the Save in box and the contents box below it to select the appropriate location
for the file to be saved.

2. In the File name box, replace the existing text with Grades.

3. Select Save. The workbook is saved and the dialog box removed.

b. Select File j Print. A dialog box is displayed.

1. Select OK. The printout contains the worksheet with a header, footer, gridlines, and
row and column headings.

$$$$$ CLOSE GRADES
Select File j Close.
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 8.9 Changing the Width of a Column

The width of a column can affect the way Excel displays numeric data.
If a cell is not wide enough to display its value, scientific notation is used.
For example, the value 123456789012 is displayed as 1.23457E+11. La-
bels are displayed in their entirety until they encounter another cell that
contains data. For example, typing This is a long label in cell A1 produces:

Cell A1 stores This is a long label. Even though B1 appears to contain
data, it is empty. Entering data in cell B1 produces:

Cell A1 still stores This is a long label, but only the characters that fit in
the width of the cell are displayed. The full contents can be seen on the
Formula bar when cell A1 is the active cell. The entire label in A1 can be
displayed by changing the width of column A.

The width of a column is changed by dragging the right boundary of
the column. Pointing to the boundary, the bar separating the column let-
ters at the top of the worksheet, changes the pointer shape to a double-
headed arrow:

Dragging the boundary changes the width of column C

Dragging the boundary to the right increases the width of the column,
and dragging to the left decreases the width. Note that the width of the
entire column is changed. The width of a single cell cannot be changed.

A quick and efficient technique for changing the width of a column is
to double-click the right boundary of the column. This changes the width
of the column so that it is just wide enough to display the data it contains.

 8.10 Selecting Cells

Adjacent worksheet cells can be selected together to form a range.
Adjacent cells are cells that are next to each other. A range is a selection of
two or more cells. Dragging the pointer from one cell to another is one
way to create a range:

Changing Row Height
Row height can be increased
or decreased by dragging the
bottom boundary of the row
number or by selecting Height
from the Row submenu in the
Format menu.

adjacent cells, range

boundary
sizing a column

The Width Command
The width of a column can be
increased or decreased by se-
lecting Width from the Column
submenu in the Format menu,
which displays the Column
Width dialog box. Typing a
number in the Column width
box and then selecting OK
changes the width of the col-
umn that contains the active
cell.

The width of multiple col-
umns can be changed to the
same width by first selecting
the columns and then drag-
ging the right boundary of one
of the columns or selecting
the Width command.
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The pointer was placed on cell B2 and then dragged to
cell D5 to create this range

Another way to create a range is to first select the starting cell, then
hold down the Shift key and click the last cell in the range.

An entire row or column is selected by first pointing to a row number
or column letter, which displays an arrow indicating what row or column
is being selected, and then clicking the row number or column letter.

Clicking the Select All button selects the entire worksheet:

The keyboard can also be used to select a range by first selecting the
starting cell, then holding down the Shift key and using the arrow keys
to define the range.

 8.11 Formatting Alignments and

Fonts

Formatting is applied to cells to make the data easier to understand.
Formatting does not change the data stored in a cell, only the way it is
displayed.

Unless cells are formatted otherwise, labels are left aligned, and val-
ues and times/dates are right aligned. For this reason, labels and values
displayed in the same column do not line up. For example, the test la-
bels and dates in the Grades worksheet do not align in the column.

Selecting Cells from the Format menu displays the Format Cells dialog
box. Selecting the Alignment tab displays the options:

Cell Alignment
The Orientation option in the
Format Cells dialog box is
used to rotate cell contents.

The Vertical list in the Format
Cells dialog box is used to
change the vertical alignment
of data in a cell when the
height of the cell is larger than
the data in it.

selecting rows and columns

select  all

Selecting Non-adjacent
Cells

A range can consist of non-
adjacent cells. A range of non-
adjacent cells is created by se-
lecting the first cell or range
of cells and then holding
down the Ctrl key and  select-
ing other cells or ranges.
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Selecting Left (Indent), Center, or Right (Indent) from the Horizontal list
and then selecting OK changes the alignment of the active cell accord-
ingly. The Align Left ( ), Center ( ), and Align Right ( ) buttons
on the toolbar can also be used to change the alignment of the active cell.

Selecting the Wrap text check box allows for more than one line of text
within a cell. Excel automatically determines if the next word will fit or
if it must go to the next line in the cell. This feature is useful for long
column headings.

Selecting the Font tab in the Format Cells dialog box displays options
for changing the font, font size, and style of the data in a selected cell:

 Font and font size can also be changed by selecting format options from
the Font and Font Size boxes on the toolbar. The Bold ( ), Italic ( ),
and Underline ( ) buttons on the toolbar can also be used to change
the font style.

Font Size
Changing the font size of
worksheet labels can help dis-
tinguish between labels, such
as titles and column headings,
and the data. The row height
adjusts automatically when
the font size is changed.

Merge and Center
Data entered into a single cell
can be centered across several
cells that are combined or
merged together. Data is cen-
tered across several cells by
first entering the data in the
upper left-most cell, selecting
the cells to merge, and then
clicking the Merge and Cen-
ter button ( ) on the toolbar.

Merged cells can be split by
selecting the merged cells and
then clicking the Merge and
Center button.

Character Formatting
When the active cell is for-
matted, the entire contents of
the cell are affected. To for-
mat only a few characters in
an active cell, select the char-
acters on the Formula bar and
then apply the format.

Clearing Cell Formats
Selecting Formats from the
Clear submenu in the Edit
menu removes any formatting
applied to the active cell and
leaves the data unchanged.

Selecting All from the Clear
submenu in the Edit menu re-
moves the contents and for-
matting of the active cell.
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 8.12 Formatting Numeric Data

Cells storing numeric data should be properly formatted to reflect the
type of value stored. For example, values representing money should
display a $ sign and two decimal places. Selecting Cells (Ctrl+1) from the
Format menu displays the Format Cells dialog box. Selecting the Number
tab displays numeric formatting options:

• Number formats the active cell to display values with two deci-
mal places.

• Currency formats the active cell to display values with a dollar
sign and two decimal places.

• Accounting is similar to Currency except the dollar sign aligns
itself at the left edge of the cell. Clicking the Currency Style but-
ton ( ) on the toolbar is the same as applying the Accounting
format.

• Percentage formats the active cell to display values as a per-
centage with two decimal places. For example, a cell storing the
value 0.15 formatted as percentage displays 15.00%. Clicking
the Percent Style button ( ) on the toolbar formats the cell as
percentage with no decimal places.

• Scientific formats the active cell to display values in scientific
notation with two decimal places.

There are three options associated with numeric formats. The number of
decimal places can be changed by selecting or typing a number in the
Decimal places box. For large numbers, the Use 1000 Separator (,) check
box displays values with separating commas, such as 1,000,000. The
Negative numbers list displays different formats for negative numbers.

A cell is automatically formatted if a $, %, or a decimal position is typed
with the number. For example, entering $45.67 in a cell formats that cell
to display any number with a dollar sign and two decimal places. If 34 is
then entered in that cell, $34.00 is displayed. Entering 45% in a cell
formats that cell to display any number with a percent sign and no
decimal places. If 55.3 is then entered in that cell, 55% is displayed.

Getting Rid of ####
Formatting a value in a cell
may add additional characters
to the value. For example, se-
lecting the Currency Style but-
ton adds a dollar sign, a deci-
mal point, and two decimal
places to the value.

If the column is not wide
enough to display the addi-
tional characters, a series of
number signs (###) is dis-
played in the cell. Increasing
the width of the column re-
moves the number signs and
displays the value and its for-
matting.

Displaying the Format
Cells Dialog Box

The Format Cells dialog box
can also be displayed by right-
clicking a cell or range of cells
and then selecting Format Cells
from the menu.

Decimal Places
The number of decimal places
in a selected format can be
changed by selecting the
Increase Decimal button ( )
or the Decrease Decimal
button ( ) on the toolbar.
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Formatting a cell does not change the value that is stored in the cell,
only how that value is displayed. Number signs (####) are displayed if a
cell is not wide enough to display the formatted number.

Time/date values can also be formatted by selecting one of the many
Date or Time options in the Format Cells dialog box. Examples of date
formats include 3-14-01 and March 14, 2001. Examples of time formats
include 1:30:55 PM and 1:30 PM.

Cell formatting can be copied to another cell or range of cells by first
selecting the cell that contains the formatting to be copied and then se-
lecting the Format Painter button ( ) on the toolbar, which changes
the pointer to a plus sign and a paint brush ( ). Clicking a cell or
range of cells copies the selected cell’s formatting.

 Practice 3 ööööö

In this practice you will format the Grades workbook. Start Excel if it is not already running.

!!!!! OPEN GRADES
Select File j Open. A dialog box is displayed.

1. Use the Look in list and the contents box below it to display the file name Grades.

2. In the contents box, click Grades.

3. Select Open. A copy of Grades is transferred to the computer’s memory and a window
is displayed with the worksheet.

@@@@@ BOLD THE NAME LABEL
a. Select cell A1.

b. On the toolbar, click the Bold button ( ). The label is now bold.

##### WIDEN COLUMN A BY DRAGGING
Note that the label in cell A7 is cut off because the column is too narrow to display it entirely.

a. Point to the boundary between columns A and B. The pointer changes to a double-headed
arrow ( ).

b. Drag the boundary to the right approximately halfway across column B. Column A should
be wide enough to display the entire label in cell A7. If not, drag the column boundary
farther to the right.

$$$$$ RIGHT ALIGN AND BOLD THE TEST LABELS
a. Drag the pointer from cell B1 to cell D1. Cells B1 through D1 are selected as a range.

b. Select Format j Cells. A dialog box is displayed.

1. Select the Alignment tab if the those options are not already displayed.

2. In the Horizontal list, select Right (Indent).

3. In the Indent box, select or type 0 if it is not already displayed.

4. Select the Font tab. The font options are displayed.

5. In the Font style list, select Bold.

6. Select OK. The labels are right aligned and bold.

Format Painter button

time/date
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%%%%% COPY CELL FORMAT
a. Select cell D1.

b. On the toolbar, click the Format Painter button ( ). The pointer changes to a plus sign and
a paint brush ( ) when moved onto the worksheet.

c. Click cell E1. The format of cell D1 is copied to cell E1.

^̂̂̂̂ FORMAT THE DATES
a. Select cell B2.

b. Hold the Shift key down and then click cell E2. Cells B2 through E2 are selected as a range.

c. Select Format j Cells. A dialog box is displayed.

1. Select the Number tab. The number formatting options are displayed.

2. In the Category list, click Date if it is not already selected.

3. Scroll the Type list if necessary until a date similar to 3/14/01 is displayed.

4. Click the date to select it.

5. Select OK. The dates in row 2 now display the year with two digits.

&&&&& SAVE AND CLOSE THE MODIFIED GRADES
a. Select File j Save. The workbook is saved.

b. Select File j Close. The workbook is removed from Excel.

***** QUIT EXCEL
Select File j Exit. Excel is removed from the screen.

 8.13 Using Formulas to Perform

Calculations

One benefit of using a worksheet is its ability to perform calculations
using formulas. Formulas are mathematical statements used to calculate
values. Every formula in Excel must begin with an equal sign (=). For
example, entering the formula =25 * 3 in a cell displays the value 75.

The following mathematical operators can be used in a formula:

Exponentiation ^
Multiplication *
Division /
Addition +
Subtraction –

Exponentiation means to raise a value to a power and is represented by
the caret (^) symbol. For example, 23=8 is expressed as 2^3 = 8.

The Formula Bar
The Formula bar displays the
contents of the active cell in-
stead of the value displayed in
the cell. For example, if the
Formula bar shows =2+3, the
cell displays 5. When looking
for errors in a worksheet, the
Formula bar is the first place
to start.
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Excel evaluates a mathematical expression using a specific order of
operations. Exponentiation is performed first, multiplication and division
next, and then addition and subtraction. Two operators of the same pre-
cedence, for example + and –, are evaluated in order from left to right.
For example, the expression 5 + 2 * 3 – 1 evaluates to 10 because multi-
plication is performed first and then the addition and subtraction. For
example:

Formula Resulting value
=2*2+3*2 10
=25*8/4 50
=35+12/3 39
=3+5*8+7 50

The order in which Excel evaluates a mathematical expression can be
changed by including parentheses in an expression. Operations within
parentheses are evaluated first. For example, the result of (5 + 2) * 3 – 1
is 20 because 5 and 2 were added before the multiplication and subtrac-
tion was performed. For example:

Formula Resulting value
=(3+5)*(8+7) 120
=3^2*8-4 68
=6+2^2 10
=(6+2)^2 64

When a formula is entered in a cell, Excel automatically checks the
formula for errors. Entering an invalid formula in a cell causes Excel to
display an error value in the cell and a triangle in the upper-left corner
of the cell. For example, a number cannot be divided by zero because the
result is mathematically undefined. Therefore, entering =10/0 displays

 in the cell.

Selecting the cell with the error value displays the Trace Error button
( ) to the left of the cell. Clicking the Trace Error button displays a list
of options:

The error is described in the top gray line of the list. Selecting Ignore
Error removes the Trace Error button and the triangle from the worksheet.
Selecting Edit in Formula Bar places the formula on the Formula bar where
it can be edited.

Triangle Indicators
The triangle indicators that
appear in cells have different
meanings depending on the
triangle’s placement and
color.

A green triangle in the upper-
left corner of a cell indicates
an error. A red triangle in the
upper-right corner of a cell  in-
dicates a comment has been
added to the cell. A comment
is a note that explains the cell
contents. A purple triangle in
the lower-right corner of a cell
indicates a smart tag. Smart
tags recognize certain types of
data that are commonly used
in other applications.

Remembering the
Order of Operations

To remember the order of
operations, memorize this
simple phrase:

Please
Excuse

My Dear
Aunt Sally

The initials correspond to the
order in which the mathemati-
cal expression is evaluated:

Parenthesis
Exponents

Multiply Divide
Add Subtract

formula error checker
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 Practice 4

In this practice you will enter formulas into the cells of a new, empty workbook to perform calculations.

!!!!! CREATE A NEW WORKBOOK

@@@@@ ENTER LABELS
a. Enter the label Example Formulas in cell A1.

b. Bold the label. Note that the text extends into the next cell.

c. Double-click the boundary between columns A and B. Column A is widened just enough to
display the label.

d. Select cell A2 and enter the label Formula.

e. Select cell B2 and enter the label Result.

f. Italicize both labels and right align the label in cell B2.

##### ENTER A LABEL AND A FORMULA
a. Select cell A3.

b. Type 20/50 and then click the Enter button. The result is a label because it is not preceded
by an equal sign.

c. Select cell B3.

d. Type =20/50 and then click the Enter button. The result 0.4 is displayed. Note that the formula
is displayed on the Formula bar, and the result of the formula is shown in the cell:

$$$$$ ENTER FORMULAS
a. Enter each of the labels and formulas shown below in the cells indicated. Note the resulting

values of the formulas:

In cell A4 enter 20*50 In cell B4 enter =20*50 to display 1000

A5 20–50 B5 =20–50 –30

A6 2+20*5+50 B6 =2+20*5+50 152

A7 (2+20)*(5+50) B7 =(2+20)*(5+50) 1210

A8 20/0 B8 =20/0 #DIV/0!

b. Select cell B8 if it is not already selected. Note the triangle in the top-left corner and the
Trace Error button ( ).

c. Click the Trace Error button. A list of options is displayed. Note the first entry indicates the
formula contains a “Divide by Zero Error”.

1. Select Ignore Error. The triangle and the Trace Error button are removed.

%%%%% SAVE THE WORKBOOK
Save the workbook in the appropriate folder naming it Formula Examples.
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 8.14 Using Cell References in

Formulas

A cell reference may be used in a formula so that the value stored in
the cell is used in the calculation of the formula. When Excel evaluates
the formula, it uses the cell reference to locate the value needed in the
calculation. For example, in the worksheet below cell C1 contains a for-
mula that references values in cells A1 and B1:

As a cell reference is typed, the border of the referenced cell is outlined
in a colored border. Cell references can be typed in uppercase or lower-
case letters. However, Excel automatically converts a cell reference to
uppercase letters when entered.

Formulas that contain cell references are automatically recalculated
when the value in a referenced cell changes. For example, in the
worksheet below, cell D2 contains a formula that references cells B2 and
C2. If the value in cell B2 or C2 changes, the formula will automatically
recalculate:

  

A formula cannot reference the cell it is stored in. For example, the
formulas above cannot be stored in cells B3 or C2 because this would
cause an error called a circular reference.

 Practice 5 ööööö

In this practice you will enter formulas that contain cell references. Open Formula Examples if it is not
already displayed.

!!!!! ENTER A LABEL AND VALUES
a. Select cell A10 and enter the label Example Formulas with Cell References.

b. Bold the label.

c. Select cell A11 and enter the label Formula.

d. Select cell B11 and enter the label Result.

e. Italicize both labels and right align the label in cell B11.

f. Select cell E10 and enter the value 20.

g. Select cell F10 and enter the value 50.

Circular References
A circular reference occurs
when a cell’s formula refers to
itself.  For example, placing
the formula =B5–C1 in cell B5
creates a circular reference.

A circular reference also oc-
curs when a cell’s formula re-
fers to another cell that con-
tains a cell reference to the
current cell.  For example,
placing the formula =B5–C1
in cell D10 creates a circular
reference if either B5 or C1
contain a formula that refer-
ences D10.

A dialog box is displayed if a
circular reference occurs.
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@@@@@ ENTER FORMULAS
a. Select cell A12.

b. Type E10/F10 and then click the Enter button. The result is a label because it is not preceded
by an equal sign.

c. Select cell B12.

d. Enter the formula =E10/F10. Note that as a cell reference is typed, the border of the cell is
outlined in a colored border. The result 0.4 is displayed.

e. Enter each of the labels and formulas shown below in the cells indicated. Note the resulting
values of the formulas:

In cell A13 enter E10*F10 In cell B13 enter =E10*F10 to display 1000

A14 E10-F10 B14 =E10–F10 –30

A15 2+E10*5+F10 B15 =2+E10*5+F10 152

A16 (2+E10)*(5+F10) B16 =(2+E10)*(5+F10) 1210

A17 E10^2+F10^2 B17 =E10^2+F10^2 2900

A18 (E10+F10)^2 B18 =(E10+F10)^2 4900

##### CHANGE THE VALUE IN CELL E10
a. Select cell E10.

b. Enter 30 to replace the current value. Every formula in the worksheet referencing cell E10 is
automatically recalculated. A key advantage of using formulas with cell references is that
they automatically recalculate when values in the cells they reference change.

Check – Your worksheet should look similar to:

$$$$$ SAVE, PRINT, AND THEN CLOSE THE MODIFIED FORMULA EXAMPLES
a. Create a header with the date center aligned and a footer with your name right aligned.

b. Save the modified Formula Examples.

c. Print a copy of the worksheet.

d. Close the workbook.
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 8.15 Using Functions to Perform

Calculations

For performing common calculations, Excel contains built-in functions
that can be included in a formula. A function performs a calculation that
results in a single value. A function requires data, called arguments, to
perform its calculation. The arguments of a function are enclosed in pa-
rentheses after the function name and are usually cell references.

The SUM function adds the values of the cells in the range. For ex-
ample, to add the values stored in cells A1, B5, and E7, a formula is used
that contains the built-in SUM function can be used:

In the example above, the values to be summed are stored in nonadja-
cent cells. Therefore, the SUM arguments are separated by commas. When
adjacent cells are the arguments of a function, a range of cells may be
referenced by typing the first cell reference followed by a colon (:) and
then the last cell reference. For example, to add the values in cells G1,
G2, and G3:

As a range is typed, the border of the range is outlined with a colored
border and the value produced from the calculation is formatted with
the same format as the argument cells.

Functions are useful because they often make a formula shorter and
are less error-prone, especially when a large range of cells is involved.
As a function is being typed, an argument tooltip is displayed illustrat-
ing the structure, or syntax, of the function:

Another function is AVERAGE, which adds the values of the cells in
the range and then divides the result by the number of cells in the range.
For example, the formula =AVERAGE(C12:C17) sums the values in cells
C12, C13, C14, C15, C16, and C17 and then divides the total by 6.

The SUM and AVERAGE functions ignore cells that contain text or
are empty when their cell references are included as arguments.

 AVERAGE function

Typing Functions
Functions can be typed in up-
percase or lowercase letters.
However, Excel automatically
converts a function to upper-
case letters when entered.

function
arguments

 SUM function
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 8.16 Common Error Values

If a formula cannot produce a result, an error value is displayed in the
cell. For example, the #DIV/0 error value indicates the formula is trying
to divide by zero. Other common error values include:

#REF The formula contains a reference that is not valid.

#NUM A numeric value is invalid, such as a value that is too
large or too small.

#VALUE The formula is using the wrong type of argument, such
as a label instead of a value.

#### The result of the formula is too wide to fit in the column. If
the result should fit in the column, check the formula for errors.
This error value can also indicate that the result of the formula
is a negative time or date value.

Selecting the cell with the error value displays the Trace Error button
( ) to the left of the cell. Clicking the Trace Error button displays a list
of options for correcting the error.

 Practice 6

In this practice you will use functions to calculate the total and average sales for a candy store.

!!!!! OPEN CANDY SALES
Open CANDY SALES, which is a data file for this text.

@@@@@ FORMAT THE CELLS
a. Select cells B2 through B10. The sales amounts are selected as a range.

b. Select Format j Cells. A dialog box is displayed.

1. Select the Number tab if those options are not already displayed.

2. In the Category list, select Currency.

3. Select or type 2 in the Decimal places box if it is not already there.

4. Select OK. The values are displayed as currency with 2 decimal places.

##### USE A FUNCTION TO SUM THE VALUES
Select cell B11 and enter the formula:

=SUM(B2:B10)

The sum $300,632.03 is displayed. Note how the total is also formatted as currency because it
is summing values that have already been formatted as currency.

$$$$$ USE A FUNCTION TO AVERAGE THE VALUES
Select cell B12 and enter the formula:

=AVERAGE(B2:B10)

The average sales, $33,403.56, is displayed in cell B12.



8 – 22 A Guide to Microsoft Office XP Professional

%%%%% CREATE A HEADER AND FOOTER
Create a header with the date center aligned and a footer with your name right aligned.

^̂̂̂̂ SAVE, PRINT, AND THEN CLOSE THE MODIFIED CANDY SALES

 8.17 Entering Formulas - Pointing

When typing a formula, cell references can be entered by pointing.
Pointing is a technique where a formula is typed up to where a cell refer-
ence should appear and then a cell is clicked, which places its reference
in the formula. Selecting a range of cells places the cell range in the for-
mula. Pointing is the best method for entering cell references into a for-
mula because typing errors are avoided.

For example, in the worksheet below, =SUM( was typed into cell C5.
The range was then entered into the formula by dragging the pointer
from cell C2 to cell C4. The colon (:) is automatically inserted by Excel:

Selecting a block of cells enters its range into a formula

The formula is completed by clicking the Enter button or pressing Enter.
Note that Excel automatically adds a right parenthesis.

 8.18 Displaying Formulas

Worksheet formulas are displayed at their cell locations by pressing
Ctrl+  ̀(grave accent):

Before pressing Ctrl+`

After pressing Ctrl+`
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The grave accent key is located above the Tab key on the keyboard. When
formulas are displayed, column widths may need adjusting. The For-
mula Auditing toolbar, which contains advanced formula editing fea-
tures, is automatically displayed.

Displaying formulas does not change the worksheet, only the way it
is displayed. Printing when formulas are displayed prints the formulas
stored in the cells rather than the values. Pressing Ctrl+  ̀again removes
the Format Auditing toolbar and displays values in each cell, although
any column widths that were increased remain wider and need to be
reformatted.

 Practice 7 ööööö

In this practice you will enter formulas to calculate the average grade on a test and a student’s average in
the Grades worksheet.

!!!!! OPEN GRADES
Open Grades, which was last modified in Practice 3.

@@@@@ USE A FORMULA TO AVERAGE THE GRADES FOR TEST 1
a. Select cell B10.

b. Type =AVERAGE(

c. Select cells B4 to B9. Excel enters the cell references for the selected range into the formula.

d. Press Enter. The average for Test 1, 83.33333, is displayed in cell B10.

##### CALCULATE A STUDENT’S AVERAGE
Select cell F4 and use pointing to enter the formula =AVERAGE(B4:E4). The average 85.25 is
displayed.

$$$$$ ADD TITLES FOR THE NEW INFORMATION
a. Select cell F1 and enter the label Student Average.

b. Format the label as bold and right aligned if it is not already formatted.

c. Change the column width so that the label is displayed entirely.

d. Select cell A10 and enter the label Test Average.

e. Format the label as italic and right aligned.

%%%%% VIEW AND PRINT THE FORMULAS
a. Save the modified Grades.

b. Press Ctrl+` (located above the Tab key). Worksheet formulas are displayed at their cell loca-
tions and the Formula Auditing toolbar is displayed.

c. Press Ctrl+  ̀to again display only the values of each cell.

^̂̂̂̂ SAVE THE MODIFIED GRADES
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 8.19 Copying Adjacent Cells

Cell contents are copied to adjacent cells using the Fill handle. The Fill
handle is the solid square in the lower-right corner of a selected cell or
range:

The pointer changes to a  when placed on the Fill handle. Dragging the
Fill handle copies the contents of the selected cell or range to the selected
adjacent cells:

The contents of cell B8 is copied to adjacent cells
by dragging the Fill handle

When the Fill handle is used to copy cell contents, the Auto Fill Options
button ( ) is displayed below and to the right of the last cell in the range.
The Auto Fill Options button is removed when a key is pressed or a com-
mand is selected.

Commands from the Fill submenu in the Edit menu can also be used to
copy the contents of a cell to adjacent selected cells. Down (Ctrl+D) is used
if the selected cells are in a column, and Right (Ctrl+R) is used if the se-
lected cells are in a row.

 8.20 Copying Formulas

When a formula is copied, the cell references in the formula are auto-
matically changed relative to the new row or column. For example, in
the worksheet below, cell B10 contains the formula =SUM(B5:B9). Copy-
ing this cell to cells C10 and D10 creates the formula =SUM(C5:C9) in
cell C10 and =SUM(D5:D9) in cell D10.

The Auto Fill Options
Button

Clicking the Auto Fill Options
button displays a list of op-
tions including:

Copy Cells is the default setting
that copies both the cell con-
tents and formatting.

Fill Series creates a series out
of the copied data.

Fill Formatting Only copies the
format from the selected cell
and not the content.

Fill Without Formatting copies
the cell contents and not the
formatting.

Series
If a cell contains a date, time,
or a combination of text and
a number, then a series is cre-
ated when the Fill handle is
dragged. For example, in the
spreadsheet below, cells A1
through A3 were selected and
then the Fill handle dragged
to cell C3:

A series of numbers is also
created by selecting two cells
and then dragging the Fill
handle. For example, select-
ing a cell that contains 2 and
an adjacent cell that contains
4 and then dragging the Fill
handle produces a series of
even numbers; 6, 8, 10, and
so on.

Fill handle
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Cell references that reflect the row or column they have been copied to
are called relative cell references.

 8.21 The ROUND Function

The ROUND function changes a value by rounding it to a specific num-
ber of decimal places. The first argument of the ROUND function is the
value to be rounded, and the second argument is the number of decimal
places to which the result is rounded. For example, to round the value
stored in cell C16 to one decimal place, the formula =ROUND(C16,1) is
used. If the value stored in C16 is 42.851, the rounded result is 42.9.

Often the result of a formula should be rounded. For example, the test
averages should be rounded to 1 decimal places in the Grades worksheet.
This means that the class average on Test 1 would be computed as 83.3,
not 83.33333. To round the result of a formula, the formula is the first
argument and the desired number of decimal places to round to is the
second argument. For example, the average of all the Test 1 grades is
rounded to 1 decimal place with the formula:

=ROUND(AVERAGE(B3:B8),1)

To round a value to the nearest whole number, a 0 can be used to indicate
no decimal places: =ROUND(AVERAGE(B3:B8),0).

 Practice 8 ööööö

In this practice you will copy the formulas in the Grades worksheet and use the ROUND function. Open
Grades if it is not already displayed.

!!!!! COPY A FORMULA USING THE FILL HANDLE
a. Select cell B10. Note the Fill handle in the lower-right corner of the cell.

b. Point to the Fill handle of the cell. The pointer changes to cross hairs ( ).

c. Drag the Fill handle from cell B10 to cell E10. The formula is copied to cells C10 through E10
and the Auto Fill Options button is displayed. The Auto Fill Options button will not be
used and should be ignored.

d. Select cell E10. Note that the formula displayed on the Formula bar shows how the cell
references have been automatically changed.

Rounding vs. Formatting
Formatting only affects the
way the information is
displayed. Whereas, the
ROUND function changes the
value stored in the cell.

Excel follows certain rules
when rounding numbers. A
number with a decimal por-
tion greater than or equal to
0.5 is rounded up and a num-
ber with a decimal portion
less than 0.5 is rounded
down.

A negative number as the sec-
ond argument of the ROUND
function rounds a value to the
nearest 10s, 100s, etc. For ex-
ample =ROUND(72.86,-1) dis-
plays 70. The formula
=ROUND(72.866,-2) displays
100.

relative cell references



8 – 26 A Guide to Microsoft Office XP Professional

@@@@@ COPY ANOTHER FORMULA USING THE FILL HANDLE
a. Select cell F4.

b. Drag the Fill handle from cell F4 to cell F9. The formula is copied. The first Auto Fill Op-
tions button is removed and another Auto Fill Options button appears below and to the
right of cell F9. The Auto Fill Options button will not be used and should be ignored.

##### ROUND A TEST AVERAGE TO 1 DECIMAL PLACE
a. Select cell B10.

b. On the Formula bar, click between the equal sign and the word AVERAGE and type: ROUND(

c. Click at the end of the formula and type ,1) so that the formula on the Formula bar is:

=ROUND(AVERAGE(B4:B9),1)

Click the Enter button. The average is now rounded to 1 decimal place, 83.3.

$$$$$ ROUND ALL TEST AVERAGES TO 1 DECIMAL PLACE
a. Select cell B10 if it is not already selected.

b. Drag the Fill handle from cell B10 to cell E10. The formula is copied.

%%%%% ROUND A STUDENT AVERAGE TO 1 DECIMAL PLACE
a. Select cell F4.

b. On the Formula bar, click between the equal sign and the word AVERAGE and type: ROUND(

c. Move the cursor to the end of the formula and type ,1) so that the formula is:

=ROUND(AVERAGE(B4:E4),1)

Click the Enter button. The average is now rounded to 1 decimal place, 85.3.

^̂̂̂̂ ROUND ALL STUDENT AVERAGES TO 1 DECIMAL PLACE
a. Select cell F4 if it is not already selected.

b. Use the Fill handle to copy the formula in cell F4 to cells F5 through F9.

&&&&& FORMAT STUDENT AVERAGES TO DISPLAY 0 DECIMAL PLACES
a. Select cells F4 through F9 if they are not already selected.

b. Select Format j Cells. A dialog box is displayed.

1. Select the Number tab if those options are not already displayed.

2. Select Number.

3. Select or type 0 in the Decimal places box.

4. Select OK. The averages are displayed with 0 decimal places.

5. Click on a blank cell to remove the selection. The selection is removed.
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Check – Your worksheet should look similar to:

***** SAVE, PRINT, AND THEN CLOSE THE MODIFIED GRADES
a. Save the modified Grades.

b. Display formulas. Change the column widths as necessary so all the formulas are displayed
entirely.

c. Print the worksheet.

d. Close the workbook without saving changes. The only change that is not being saved is the
displaying of the formulas.

((((( QUIT EXCEL

Chapter Summary

A spreadsheet is data displayed in rows and columns. A spreadsheet
application, such as Microsoft Excel, is used to electronically store data.
Benefits of using a spreadsheet application include the ability to easily
perform calculations on data and to automatically recalculate values when
changes are made to the data.

In Excel, spreadsheet files are called workbooks, and each workbook
contains three worksheets, also called sheets. Worksheets are used to
present data in an organized format.

A new workbook is created by selecting the Blank Workbook icon and
then OK in the New Office Document dialog box. In the Excel window,
rows are identified by numbers and columns by letters. A cell is the
intersection of a row and column and is identified by its cell reference.
For example, D4 is the cell reference of the cell located at the intersection
of column D and row 4. The selected cell is called the active cell and is
displayed with a bold outline. The Name box displays the cell reference
of the active cell, and the Formula bar displays the contents of the active
cell.

Worksheet cells can store three types of data: labels, values, and
times/dates. Labels are text and cannot be used in calculations. Values
are numeric and can be used in calculations. Times/dates are either times
(10:30 AM) or calendar dates (9/21/2003), and both can be used in cer-
tain types of calculations.

workbook
worksheet

spreadsheet application

active cell

Name box

labels, values
times/dates
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Data is entered into a cell by selecting that cell, typing the data and
then pressing the Enter button. Pressing the Enter key, Tab key, or ar-
row key after typing data into a cell enters the data and then moves the
active cell to an adjacent cell, in a direction depending on which key is
pressed.

Data in a cell is edited by first selecting the cell to display its contents
on the Formula bar. Next, clicking the Formula bar creates an insertion
point, which allows characters to be entered or deleted. The contents of
a selected cell are erased by pressing the Delete key. If a cell is cleared by
mistake, immediately selecting Undo from the Edit menu or the Undo but-
ton on the toolbar restores the contents of the cell.

Selecting Save (Ctrl+S) from the File menu or clicking the Save button
on the toolbar saves the workbook. A saved workbook that has been
closed may be opened later by selecting Open from the File menu or by
selecting the Open button on the toolbar. Excel is quit by selecting Exit
from the File menu.

Selecting Print Preview from the File menu or the Print Preview button
on the toolbar displays the worksheet as it will appear when printed. In
Print Preview, selecting Print displays the Print dialog box where select-
ing OK prints the portion of the worksheet that contains data. A worksheet
can also be printed by selecting Print from the File menu. Gridlines and
row and column headings can make a worksheet printout easier to read.
Information such as the date or the file name can be included in a header
or footer to help identify printouts. Headers and footers are automati-
cally printed at the top and bottom of each worksheet page, respectively.

The width of a column is changed by dragging its right boundary or
double-clicking the right boundary of the column.

Adjacent worksheet cells can be selected together to form a range.
Adjacent cells are cells that are next to each other. A range is a selection
of two or more cells.

Formatting is applied to cells to make the data easier to understand.
Formatting does not change the data stored in a cell, only the way it is
displayed. The Cells command from the Format menu is used to display
the Format Cells dialog box where formatting options can be selected.
The toolbar can also be used to select formatting options.

Formulas are mathematical statements used to calculate values. All
formulas must begin with an equal sign (=) and may contain cell
references. For example, if cell B5 stores the value 12 and cell C8 stores
10, the formula =B5*C8 would display 120. Excel uses an order of
operations when evaluating a formula. First it performs exponentiation,
then multiplication and division, and finally addition and subtraction.
Operations of the same priority are performed from left to right. The order
of operations is changed by using parentheses.

When a formula is entered in a cell, Excel automatically checks the
formula for errors. Entering an invalid formula in a cell causes Excel to
display an error value in the cell and a triangle in the upper-left corner
of the cell.

error checking

editing cell contents

deleting cell contents

gridlines
row and column headings

headers and footers

changing column width

range

formatting

formulas
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SUM

AVERAGE

ROUND

pointing
displaying formulas

Fill handle

relative cell references

Excel contains built-in functions that are used to perform common cal-
culations. The formula =SUM(B3:B8) includes the SUM function. The
formula’s argument, B3:B8, is called a range and defines the cells to be
summed. The formula =AVERAGE(C3:C7) averages the values in the cells
C3, C4, C5, C6, and C7. The formula =ROUND(C5,2) rounds the value
stored in cell C5 to two decimal places. Similarly, the formula
=ROUND(AVERAGE(B7:F7),1) rounds the average of the values in the
range B7:F7 to one decimal place.

Cell references can be entered into a formula by clicking the cell. This
technique is called pointing. The formulas in a worksheet are displayed
by pressing Ctrl+`.

The contents of a selected cell or block of cells are copied to a row or
column of adjacent cells by dragging the Fill handle or selecting the Down
and Right commands from the Fill submenu. When this is done, the cell
references in the copied formulas automatically change to reflect the new
row or column they are in. Cell references that reflect the row or column
they have been copied to are called relative cell references.
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Vocabulary

Insertion Point  A blinking vertical line that indi-
cates where the next character typed will be placed.

Label  Text stored in a cell that cannot be used in
calculations.

Microsoft Excel   A spreadsheet application in the
Microsoft Office suite.

Name box   Located near the top of the worksheet
window. Displays the cell reference of the active cell.

Order of operations   The rules Excel uses to evaluate
a mathematical expression.

Pointing   Clicking a cell to place its reference in a
formula.

Range   Selection of two or more cells.

Relative cell reference   A cell reference that when
copied reflects the row or column it has been copied
to.

ROUND   Function that changes a value by rounding
it to a specific number of decimal places.

Row number   The number down the left side of the
worksheet used to identify individual rows.

Scroll bars   Used to display rows and columns not
currently visible in the worksheet.

Sheet tabs   Used to display the three worksheets in
the workbook.

Spreadsheet Data displayed in rows and col-
umns.

Spreadsheet application   Used to electronically store
data. Microsoft Excel is an example.

SUM   Function that adds the values in a range of
cells.

Tab key   Enters data and then selects the next cell in
the row.

Time   Data in the form of a time (i.e., 12:30 PM).

Value   Numeric data that is stored in a cell that can
be used in calculations.

Workbook   An Excel spreadsheet file.

Worksheet   Sheets in an Excel workbook used to
present data in an organized format.

Active cell  The selected cell displayed with a bold
outline. Data can only be entered into an active cell.

Adjacent cells  Cells that are next to each other.

Argument   Data required by a function to perform
calculations.

Arrow keys   Enters data and then selects the next cell
in the direction of the arrow key.

AVERAGE   Function that adds the values of the
cells in a range and divides the result by the number
of cells in the range.

Boundary   The bar separating the column letters at
the top of the worksheet.

Cell   The intersection of a row and column. Each cell
can store a single item of data.

Cell reference   The column letter and row number
used to identify a cell, such as B3.

Circular reference   An error that occurs when a for-
mula references the cell it is stored in.

Column letter  Letter at the top of the worksheet
used to identify individual columns.

Date   Data in the form of a calendar date.

Enter key   Enters data and then selects the next cell
in the column.

Esc key   Cancels data entry and restores the original
contents of the cell.

Fill handle   The solid square in the lower-right cor-
ner of a selected cell that is used to copy the contents
of a cell to adjacent cells.

Formula   Mathematical statement used to calculate
a value. A formula must always begin with an equal
sign. For example, =C5+D7+E8 is a formula.

Formula bar   Area near the top of the worksheet
window that displays the contents of the active cell.

Function   Performs a calculation that results in a
single value. The formula =SUM(B3:B8) contains the
SUM function.

Gridlines   Solid lines that mark off the rows and
columns in a worksheet.
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Excel Commands and Buttons

 Align Left button   Left aligns the contents of the
active cell. Found on the toolbar.

 Align Right button   Right aligns the contents of
the active cell. Found on the toolbar.

 Auto Fill Options button   Displayed when the
Fill handle is used to copy cell contents.

 Bold button   Formats the active cell as bold.
Found on the toolbar.

 Cancel button   Cancels data entry and restores
the original contents of the cell. Found on the For-
mula bar.

Cells command   Displays a dialog box where align-
ment, font, and number formatting options are se-
lected. Found in the Format menu.

 Center button   Centers aligns the contents of the
active cell. Found on the toolbar.

Close command   Removes the worksheet from the
Excel window and the computer’s memory. Found
in the File menu.

 Currency Style button   Applies the Accounting
format to the active cell. Found on the toolbar.

Down command   Copies the cell contents into the
selected cells of a column. Found in the Fill submenu
in the Edit menu.

Edit in Formula bar command   Places the formula on
the Formula bar where it can be edited. Found in the
list displayed by clicking the Trace Error button.

 Enter button   Enters data and leave the active cell
in its current position. Found on the Formula bar.

Exit command   Quits Excel. Found in the File menu.
The Close button ( ) can be used instead of the com-
mand.

Font box   Displays a list of fonts to choose from.
Found on the toolbar.

Font Size box   Displays a list of font sizes to choose
from. Found on the toolbar.

 Format Painter button   Copies cell formatting.
Found on the toolbar.

Ignore Error command   Removes the Trace Error
button and the triangle from the worksheet. Found
in the list displayed by clicking the Trace Error button.

 Italic button   Formats the active cell as italic.
Found on the toolbar.

New Office Document command   Displays the New
Office Document dialog box. Found in the Start menu.

Open Office Document command   Opens an existing
workbook. Found in the Start menu.

Open command   Opens a saved workbook if Excel is
running. Found in the File menu. The Open button
( ) on the toolbar can be used instead of the com-
mand.

Page Setup command   Displays a dialog box where
options for printing with gridlines and row and col-
umn headings and creating a header or footer can be
selected. Found in the File menu.

 Percent Style button   Formats the active cell as
percentage with no decimal places. Found on the
toolbar.

Print command   Displays a dialog box used for print-
ing a worksheet. Found in the File menu. The Print
button ( ) on the toolbar can be used instead of the
command.

Print Preview command   Displays the worksheet as it
will appear when printed. Found in the File menu.
The Print Preview button ( ) on the toolbar can be
used instead of the command.

Right command   Copies the cell contents into the
selected cells of a row. Found in the Fill submenu in
the Edit menu.

Save command   Saves a workbook. Found in the File
menu. The Save button ( ) on the toolbar can be
used instead of the command.

 Trace Error button   Displays a list of options for
correcting an error. Displayed when clicking a cell
that contains an error.

Undo command   Restores the previous action. Found
in the Edit menu. The Undo button ( ) on the
toolbar can be used instead of the command.

 Underline button   Formats the active cell as
underlined. Found on the toolbar.
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Review Questions

Sections 8.1 — 8.12
1. What is a spreadsheet?

2. a) What are spreadsheets called in Excel?
b) How many worksheets does a new work-

book contain?

3. List two benefits of using a spreadsheet appli-
cation.

4. List the steps for creating a new Excel workbook.

5. a) How are individual columns identified on a
worksheet?

b) How are individual rows identified on a
worksheet?

c) What are scroll bars used for?

6. a) What is a cell?
b) Give an example of a cell reference.
c) Where can data be entered?
d) What does the Name box display?
e) What does the Formula bar display?
f) What are the sheet tabs used to display?

7. List two ways to change the active cell.

8. How many of each of the following types of en-
tries are stored in the Grades worksheet shown
in Practice 1?
a) labels
b) values
c) dates
d) times

9. After selecting a cell and typing data, what hap-
pens when you:
a) click the Enter button?
b) press the Enter key?
c) press the Tab key?
d) press the Esc key?

10. a) What can be used to efficiently enter large
amounts of numeric data?

b) If a mistake has been made entering data into
a cell, how can it be corrected?

11. List the steps required to edit data in a cell.

12. What is the insertion point?

13. a) What is displayed when the Undo button ar-
row is clicked?

b) What happens to the list of previous actions
when a workbook is saved?

14. a) List two ways to save a worksheet.
b) What should be done if the worksheet has

been saved and is no longer needed?

15. a) List the steps required to view a worksheet
as it will appear when printed.

b) In Print Preview, what button can be select-
ing to enlarge the view?

16. What options can be selected from the Page
Setup dialog box to make a worksheet printout
easier to read?

17. List the steps required to have your name left
aligned and the current date right aligned in the
header of a worksheet.

18. Is it possible to change the width of only a single
cell?

19. List the steps required to increase the width of
a column.

20. a) What is a range?
b) List two ways to select the range B3 through

C12.
c) How is an entire column selected?
d) What button selects the entire worksheet?

21. List the steps required to:
a) format a cell to display a number with 3 deci-

mal places.
b) bold and right align the contents of a cell.
c) format a cell to display a value in dollars to

2 decimal places.

22. What button can be used to copy a selected cell’s
format?

Sections 8.13 — 8.21
23. Briefly explain what a formula is and give two

examples.
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24. a) What is meant by order of operations?
b) Which operation is performed first?
c) Which operation is performed last?
d) How can the order of operations be changed?

25. If 10/20 is entered into a cell, Excel considers it
a label. How must the entry be changed so that
10 will be divided by 20?

26. What value would be calculated by Excel for
each of the following formulas?
a) =2+7*5+4
b) =(2+7)*(5+4)
c) =5+10/5
d) =(5+10)/5
e) =2^3+4

27. a) What is displayed in a cell if an invalid for-
mula is entered?

b) What button is displayed when a cell with
an error value is selected?

c) Where can a description of an invalid for-
mula error be found?

28. In a formula, do cell references have to be typed
in capital letters?

29. What value would be calculated by Excel for
each of the following formulas if cell C15 stores
a value of 16 and cell D8 a value of 4?
a) =C15*D8
b) =C15+5+D8
c) =C15*5+D8
d) =C15*(5+D8)
e) =C15/D8

30. What is a circular reference?

31. a) What is a function?
b) What does a function require to perform a

calculation?

32. Write a formula that uses a function to calculate:
a) the sum of the values stored in cells B4, B5,

B6, and B7.
b) the sum of the values stored in cells B4, C4,

D4, and E4.
c) the average of the values stored in the col-

umn of cells D7 to D35.
d) the average of the values stored in the row

of cells F3 to J3.

33. List and describe two common error values.

34. What is usually the best method for entering cell
references in a formula?

35. How can the formulas stored in the cells of a
worksheet be displayed instead of the values
they calculate?

36. a) List the steps required to copy the contents
of cell A1 into cells A2, A3, A4, and A5 us-
ing the Fill handle.

b) List the steps required to copy the contents
of cell C1 into cells D1, E1, and F1 using the
Fill command.

37. a) What is a relative cell reference?
b) List the steps required to copy the formula

=AVERAGE(C5:C9) stored in cell C22 into
the range of cells D22 to G22 so that the
formula correctly calculates the average for
each column.

38. What will be displayed in cell A2 if the value
stored in cell C5 is 98.345 and the formula
=ROUND(C5,2) is stored in cell A2?

39. Using functions, write a formula to calculate:
a) the sum of the values in cells C5, C6, C7, C8,

and C9 rounded to 2 decimal places.
b) the sum of the values in cells B5, C5, D5, and

E5 rounded to the nearest integer.
c) the average of the values in cells A1, A2, A3,

B1, B2, and B3 rounded to 1 decimal place.



8 – 34 A Guide to Microsoft Office XP Professional

Exercises

Exercise  1 ——————————————————————— ActiActiActiActiActivityvityvityvityvity
A worksheet can be used to determine the time you spend on different activities during one week.

a) Create a new workbook.

b) Enter the following labels in row 1 starting in column A: Activity, Sun, Mon, Tue, Wed,
Thu, Fri, Sat.

c) Bold all the labels in row 1. Right align all the days of the week labels.

d) Change the width of columns B through H so they are just wide enough to display
the data entirely.

e) Starting in row 3, enter the appropriate label and number of hours you spend each
day of the week on each of the following activities:

• school classes
• athletics
• extracurricular groups and clubs
• studying and doing homework
• eating
• sleeping
• watching television or listening to music
• talking on the phone
• doing housework
• working at a job

Change the width of column A to display all the labels entirely. Format all the hours
to display 1 decimal place.

f) Save the workbook naming it Activity.

g) Most people’s schedules do not account for all 24 hours in a day. Include a row, after
the last activity, and enter formulas that use a function to calculate the amount of
unaccounted time in your schedule for each day. Include an appropriate label for the
unaccounted time.

h) In cell I1, enter the label Total Hours. Enter formulas that use a function to calculate
the total hours spent for the week on each activity. Format the total hours as number
with 1 decimal place if it is not already formatted.

i) In cell J1, enter the label Avg. Hours. Enter formulas that use a function to calculate
the average number of hours spent per day on each activity for the week.

j) Change the column widths as necessary so that all the data is displayed entirely.

k) Create a header with your name right aligned.

l) Save the modified Activity and print a copy with gridlines and row and column
headings.

m) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise  2 ————————————————— Squeaky Clean CarSqueaky Clean CarSqueaky Clean CarSqueaky Clean CarSqueaky Clean Carsssss
The owner of Squeaky Clean Cars wants to use a worksheet to keep track of his budgeted and actual
expenses.

a) Create a new workbook.

b) Enter the data as shown below. Change the column widths as necessary so that all
the data is displayed entirely and format the numeric values as currency with 2 deci-
mal places:

c) Save the workbook naming it Squeaky Clean Cars.

d) The owner would like to know the difference between what was budgeted and what
he actually spent. In cell D4, enter the label Difference. Enter formulas that use cell
references to subtract the actual costs from the budgeted costs.

e) In cell A11, enter the label Total: and right align it. Enter formulas that use a function
to total the Budgeted and Actual columns.

f) Bold the labels in column A and row 3. Italicize and right align the labels in row 4.
Change the column widths as necessary so that all the data is displayed entirely.

g) Create a header with your name right aligned.

h) Save the modified Squeaky Clean Cars and print a copy with gridlines and row and
column headings.

i) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.



8 – 36 A Guide to Microsoft Office XP Professional

Exercise  3 —————————————————————— Swim MeetSwim MeetSwim MeetSwim MeetSwim Meet
A swim team wants to use a worksheet to keep track of the last swim meet’s results.

a) Create a new workbook.

b) Enter the data as shown below. Change the column widths as necessary so that all
the data is displayed entirely and format the average times with an appearance simi-
lar to 13:30:55:

c) Save the workbook naming it Swim Meet.

d) In cell F1, enter the label Avg. Time. Enter formulas that use a function to calculate
the average time of each swimming event.

e) Italicize all the labels in row 1. Right align all the swimmers’ names and the Avg.
Time label in row 1. Change the column widths as necessary so that all the data is
displayed entirely.

f) Create a header with your name right aligned.

g) Create a footer with the text September 10 Swim Meet Results center aligned.

h) Save the modified Swim Meet and print a copy with gridlines and row and column
headings.

i) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise  4 ————————————————————— Student StatsStudent StatsStudent StatsStudent StatsStudent Stats
The Admissions department at a local university wants to use a worksheet to keep track of the statis-
tics on the number of undergraduate and graduate students in each college.

a) Create a new workbook.

b) Enter the data as shown below. Change the column widths as necessary so that all
the data is displayed entirely:
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c) Save the workbook naming it Student Stats.

d) In cell A8, enter the label Total: and then right align and italicize it. Enter formulas
that use a function to calculate the total number of undergraduate students and the
total number of graduate students at the university.

e) In cell A9, enter the label Average: and then right align and italicize it. Enter formu-
las that use a function to calculate the average number of undergraduate students
and the average number of graduate students at the university.

f) Format the numeric values to display commas and 0 decimal places.

g) Bold all the labels in row 1. Right align the Undergraduate and Graduate labels.
Change the column widths as necessary so that all the data is displayed entirely.

h) Create a header with your name right aligned.

i) Create a footer with the current date center aligned.

j) Save the modified Student Stats and print a copy with gridlines and row and column
headings.

k) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise  5 ——————————————————— CorCorCorCorCoral Emploal Emploal Emploal Emploal Employyyyyeeseeseeseesees
The accountant for Coral county has decided to use a worksheet for the city hall payroll.

a) Create a new workbook.

b) Enter the data as shown below. Change the column widths as necessary so that all
the data is displayed entirely and format the salaries as currency with 0 decimal places:

c) Save the workbook naming it Coral Employees.

d) Employees are paid weekly. In cell D1, enter the label Weekly Pay. Enter formulas
that use cell references to calculate the weekly pay for each employee. Weekly pay is
calculated by dividing the salary by 52 weeks in a year.

e) In cell B8, enter the label Average: and then right align and italicize it. Enter formu-
las that use a function to calculate the average salary and weekly pay for the employ-
ees. Format the average weekly pay as currency with 2 decimal places.

f) Bold all the labels in row 1. Right align the Salary and Weekly Pay labels. Change the
column widths as necessary so that all the data is displayed entirely.

g) Modify the weekly pay formulas to use a function to round the weekly pay amounts
in column D to 0 decimal places (do not round the average weekly pay formula).
Note that the average weekly pay also changes because the numbers have been
rounded.
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h) Create a header with your name right aligned.

i) Save the modified Coral Employees and print a copy with gridlines and row and
column headings.

j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise  6 ——————————————————————— DiDiDiDiDivvvvve Loge Loge Loge Loge Log
Researchers of a coral reef study want to use a worksheet to computerize their scuba diving log.

a) Create a new workbook.

b) Enter the following data starting in cell A1:

c) Save the workbook naming it Dive Log.

d) In cell A8, enter the label Average: and then right align and italicize it. Enter formu-
las that use a function to average the depth and duration of all five dives.

e) Modify the average depth and duration formulas to use a function to round the re-
sults to 0 decimal places.

f) Right align and italicize the labels in row 1. Change the column widths as necessary
so that all data is displayed entirely.

g) Create a header with your name right aligned.

h) Save the modified Dive Log and print a copy with gridlines and row and column
headings.

i) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise  7 ————————————————————— Pizza PPizza PPizza PPizza PPizza Palacealacealacealacealace
The owner of Pizza Palace wants to use a worksheet to keep track of expenses.

a) Create a new workbook.

b) Enter the data as shown below. Change the column widths as necessary so that all
the data is displayed entirely and format the expenses as currency with 2 decimal
places:

c) Save the workbook naming it Pizza Palace.

d) In cell A14, enter the label Cost of Pizza: and then right align and italicize it. Enter
formulas that use a function to calculate the total cost of each pizza type.

e) Bold the labels in rows 1 and 2.

f) Bold the labels in row 4. Right align the pizza type labels. Change the column widths
as necessary so that all the data is displayed entirely.

g) Create a header with your name right aligned.

h) Create a footer with the current date center aligned.

i) Save the modified Pizza Palace and print a copy with gridlines and row and column
headings.

j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise  8 ———————————————————— Balance SheetBalance SheetBalance SheetBalance SheetBalance Sheet
A balance sheet lists a company’s assets (what they own), liabilities (what they owe), and stockhold-
ers’ equity (the owners’ investments) as of a specific date. The owner of Northern Light’s Gym wants
use a worksheet to computerize the company’s balance sheet.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below:

c) Save the workbook naming it Balance Sheet.

d) In cell C11, enter a formula that uses a function to calculates the total assets.

e) In cell F11, enter a formula that uses cell references to calculates the total liabilities
and stockholder’s equity.

f) Create a header with your name right aligned.

g) Save the modified Balance Sheet and print a copy with gridlines and row and col-
umn headings.

h) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise  9 ———————————————————TTTTTemp Conemp Conemp Conemp Conemp Convvvvvererererersionsionsionsionsion
The local university’s Meteorology department wants to use a worksheet to convert Fahrenheit tem-
peratures to the equivalent Celsius temperatures.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below. In cell E3 enter the formula =5/
9*(B3–32) to convert the Fahrenheit temperature stored in cell B3 to degrees Celsius:

c) Save the workbook naming it Temp Conversion.

d) Modify the formula in cell E3 to use a function to round the result to 0 decimal places.
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e) Enter the following Fahrenheit temperatures in cell B3, one at a time: 0, 32, and 80.
What Celsius temperature does each of these convert to?

f) In row 5, have the worksheet convert temperatures from a Celsius temperature en-
tered in cell B5 to a Fahrenheit temperature displayed in cell E5. Use 26 for the Cel-
sius temperature. Include appropriate labels. The formula needed for converting from
degrees Celsius to Fahrenheit is =9/5*B5+32. Use a function to round the result to 0
decimal places. Change the column widths as necessary so that all the data is dis-
played entirely.

g) Enter the following Celsius temperatures in cell B5, one at a time: 0, 12, and –21.
What Fahrenheit temperature does each of these convert to?

h) Create a header with your name right aligned.

i) Save the modified Temp Conversion and print a copy with gridlines and row and
column headings.

j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise 10 ———————————————————— UpgUpgUpgUpgUpgrrrrrade Costsade Costsade Costsade Costsade Costs
A technology coordinator wants to use a worksheet to project computer-related costs through the
year 2007. Years 2002 and 2003 have already been established.

a) Create a new workbook.

b) Enter the following data starting in cell A1. Format the costs as currency with 0 deci-
mal places:

c) Save the workbook naming it Upgrade Costs.

d) Hardware is upgraded every other year with an expected 15% increase over the last
upgrade and software costs are expected to increase 7% each year starting in 2004.
The training budget is $2,500 per year. Enter formulas that use cell references to cal-
culate the costs for years 2004 through 2007.

e) Use a function to round the formulas for the hardware and software costs to 0 deci-
mal places. Format all of the numeric values as currency with 0 decimal places.

f) Format the labels in row 1 as right aligned and bold. Change the column widths as
necessary so that all the data is displayed entirely.

g) In cell E1, enter the label Total Expenses. Enter formulas that use a function to calcu-
late the total expenses projected each year. Change the column width as necessary so
that all the data is displayed entirely.
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h) Note the triangle in the upper-left corner of the cell indicating an error. Select the cell
and then click the Trace Error button. The error is described as Formula Omits
Adjacent Cells and results from the dates in column A not being included in the for-
mula that calculates the total expenses. Since the dates are not suppose to be included
in the formula, select Ignore Error from the list of options.

i) Create a header with your name right aligned.

j) Save the modified Upgrade Costs and print a copy with gridlines and row and col-
umn headings.

k) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise 11 ————————————————————— Class ScorClass ScorClass ScorClass ScorClass Scoreseseseses
Worksheets can be used to keep track of your class grades. Create a worksheet of your grades in this
class for the chapters you have covered so far. This exercise assumes assignments are graded using a
point system. For example, review questions are worth 20 points and tests are worth 100 points.

a) Create a new workbook.

b) Enter your points for the practices, review questions, exercises, and tests. Also, enter
the total points possible for each chapter. Include appropriate labels and proper for-
matting as shown below. Your worksheet will have different data but should look
similar to:

c) Save the workbook naming it Class Scores.

d) In cell H1, enter the label Total Points. Enter formulas that use a function to calculate
the total points you earned for the practices, review questions, exercises, and tests.
Also calculate the total points possible and format the totals to display commas and
0 decimal places.

e) Change the column widths as necessary so that all the data is displayed entirely.

f) In cell A8, enter the label Current Grade and then right align, bold, and italicize it. In
cell B8, enter a formula that uses cell references and a function to calculate your grade
as a percentage. Your grade is calculated by dividing the total points you earned by
the total points possible. Format your current grade as a percentage with 0 decimal
places and bold.

g) Create a header with your name right aligned.

h) Create a footer with the text Computer Class Grades center aligned.

i) Save the modified Class Scores and print a copy with gridlines and row and column
headings.
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j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.

Exercise 12 ————————————————————— CheckbookCheckbookCheckbookCheckbookCheckbook
Worksheets can be helpful with personal financial management. Sally wants to organize her finances
using a worksheet as a checkbook register.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below:

c) Save the workbook naming it Checkbook.

d) In cell F1, enter the label Balance and right align and bold it if it is not already
formatted.

e) In column F, enter formulas that use cell references to calculate the balance after each
transaction. To calculate the balance, subtract the expense from the previous balance
and add the income to the previous balance.

f) In cell C14, enter the label Total: and then right align and bold it. Enter formulas that
use a function to calculate the total expenses and total income for the month.

g) Create a header with your name right aligned.

h) Create a footer with the text Personal Finances center aligned.

i) Save the modified Checkbook and print a copy with gridlines and row and column
headings.

j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise 13 —————————————————— Income StatementIncome StatementIncome StatementIncome StatementIncome Statement
An income statement lists a company’s revenue (money they earn), expenses (money they pay out),
and net income/loss (revenue minus expenses) for a specific time period. Fluffy Bakery is a small
home business that wants to use a worksheet to produce an income statement.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below:

c) Save the workbook naming it Income Statement.

d) In row 10, enter formulas that uses a function to calculate the total revenue for each
year.

e) In row 17, enter formulas that use a function to calculate the total expenses for each
year.

f) In row 18, enter formulas that use cell references to calculate the net income or loss
for each year. The net income/loss is calculated by subtracting total expenses from
total revenue. Format the values as currency with 0 decimal places, if necessary.

g) Create a header with your name right aligned.

h) Save the modified Income Statement and print a copy with gridlines and row and
column headings.

i) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise 14 ——————————————————————— BudgetBudgetBudgetBudgetBudget
A student wants to use a worksheet to create a personal budget for her fall semester in college.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below:

c) Save the workbook naming it Budget.

d) In row 9, enter formulas that use a function to calculate the total budgeted and actual
income for each month.

e) In row 17, enter formulas that use a function to calculate the total budgeted and ac-
tual expenses for each month.

f) In cell A18, enter the label Savings: and right align and italicize it. Enter formulas
that use cell references to calculate the savings for each month. Savings are calcu-
lated by subtracting the total expenses from the total income.

g) Change the column widths as necessary so that all the data is displayed entirely.

h) Create a header with your name right aligned.

i) Save the modified Budget and print a copy with gridlines and row and column
headings.

j) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Exercise 15 ——————————————————— BrBrBrBrBrochurochurochurochurochure Costse Costse Costse Costse Costs
A worksheet can be used to calculate the costs of producing brochures in different quantities. The
cost of the brochure is made up of fixed costs and variable costs. Fixed costs remain the same no
matter how many brochures are produced. Variable costs change depending on the number of bro-
chures produced.

a) Create a new workbook.

b) Enter the data and apply formatting as shown below:

c) Save the workbook naming it Brochure Costs.

d) The breakdown of variable costs per brochure are:

100 250 500 750 1000
Paper $0.20 $0.18 $0.15 $0.12 $0.10
Printing $0.12 $0.11 $0.10 $0.09 $0.08
Labor $0.07 $0.07 $0.06 $0.05 $0.04
Shipping $0.10 $0.09 $0.08 $0.08 $0.07

Variable costs are calculated by multiplying the variable cost per brochure by the
number of brochures produced. In cells B10 through F13, enter formulas that use cell
references and the constant values listed above to calculate the variable costs. For-
mat the cells as currency with 2 decimal places.

e) In cell A14, enter the label Total Costs: and right align and bold it. Enter formulas
that use a function to calculate the total cost of producing the different quantity of
brochures. Total cost is calculated by adding the fixed costs plus the variable costs.

f) In cell A15, enter the label Cost per Brochure: and right align and bold it. Enter for-
mulas that use cell references to calculate the cost per brochure of producing the dif-
ferent quantities of brochures. Cost per brochure is calculated by dividing the total
costs by the number of brochures produced.

g) Create a header with your name right aligned.

h) Save the modified Brochure Costs and print a copy with gridlines and row and col-
umn headings.

i) Display the formulas in the cells instead of values. Change the column widths as
necessary so that the formulas are completely displayed. Print a copy with gridlines
and row and column headings.
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Advanced

Exercise 16 —————————————————————————ClubClubClubClubClub
Create a new workbook that stores relevant numbers about a club or organization that you belong to.
The worksheet should contain at least five columns and five rows of data. Include at least two formu-
las in the worksheet. Format the worksheet appropriately and include informative headers or footers.
Save the workbook naming it Club and print a copy with gridlines and row and column headings.
Print a copy of the worksheet so that formulas are displayed in the cells instead of values.

Advanced

Exercise 17 ———————————————————— VVVVVacation Costsacation Costsacation Costsacation Costsacation Costs
Create a new workbook that stores estimated costs for vacations to at least three different countries
you would like to visit. The worksheet should contain at least four columns and four rows of data.
Include at least two formulas and one function in the worksheet. Format the worksheet appropri-
ately and include informative headers or footers. Save the workbook naming it Vacation Costs and
print a copy with gridlines and row and column headings. Print a copy of the worksheet so that
formulas are displayed in the cells instead of values.

Advanced

Exercise 18 ————————————————— Fund-rFund-rFund-rFund-rFund-raiser Financesaiser Financesaiser Financesaiser Financesaiser Finances
Create a new workbook that stores financial information about a fund-raiser you have participated
in. The worksheet should contain at least six columns and six rows of data. Include at least three
formulas and two functions in the worksheet. Format the worksheet appropriately and include infor-
mative headers or footers. Save the workbook naming it Fund-raiser Finances and print a copy with
gridlines and row and column headings. Print a copy of the worksheet so that formulas are displayed
in the cells instead of values.
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